## Change History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Pages/Sections</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>All</td>
<td>Software vers. 3.0; first release of this document</td>
</tr>
<tr>
<td>C</td>
<td>All</td>
<td>Minor corrections</td>
</tr>
<tr>
<td>D</td>
<td>All</td>
<td>Software vers. 4.0</td>
</tr>
<tr>
<td>E</td>
<td>All</td>
<td>Software vers. 5.0</td>
</tr>
<tr>
<td>F</td>
<td>All</td>
<td>Software vers. 5.01</td>
</tr>
<tr>
<td>G</td>
<td>All</td>
<td>Software vers. 5.02</td>
</tr>
<tr>
<td>H</td>
<td>All</td>
<td>Add instructions for installation from CD</td>
</tr>
<tr>
<td>I</td>
<td>i, ii</td>
<td>Remove “VS-0223” from ii</td>
</tr>
<tr>
<td>J</td>
<td>All</td>
<td>Update AR address. Update Configuration, Installation of BD BBL Crystal MIND, Installation of ODBC Database Driver, and Troubleshooting sections. Update required screenshots for software version 5.05A. Correct various typos. Change all fonts to Arial.</td>
</tr>
<tr>
<td>K (11)</td>
<td>All</td>
<td>AR Address update</td>
</tr>
<tr>
<td>L (12)</td>
<td>Cover, sections 1, 2, 3.1.2, 4.1, 4.2, 4.6, 4.7, 12.4, 12.5 14, 15</td>
<td>Updated cover picture. Moved Introduction to section 1. Updated installation method and added support for Windows 7 and 10. Updated com port information and software launch procedures. Added default user name and password in language selection, restoring the database, exiting BD BBL Crystal MIND, configuring the AutoReader and printers, and a contacts list. Moved Troubleshooting to section 14 and updated messages.</td>
</tr>
</tbody>
</table>

© 2018 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.

All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in retrieval systems, or translated into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of BD, 7 Loveton Circle, Sparks, MD, 21152, USA.
Table of Contents

1. Introduction to BD BBL™ Crystal™ MIND ................................................................. 1
   1.1 BD BBL Crystal MIND Overview ................................................................. 1
   1.2 Workflow ..................................................................................................... 1

2. System Requirements and Installation ................................................................. 3
   2.1 System Configuration .................................................................................. 3
   2.2 Installing BD BBL Crystal MIND ............................................................... 3
      2.2.1 BD Crystal MIND Desktop Icon ....................................................... 6

3. BD BBL Crystal AutoReader .................................................................................. 7
   3.1 Setup .......................................................................................................... 7
      3.1.1 Connecting the Power Cable ............................................................... 7
      3.1.2 Connecting the Serial Communications Cable .................................... 7
      3.1.3 Power Switch ...................................................................................... 8
      3.1.4 Upgrade ............................................................................................. 8
   3.2 Warmup Cycle .............................................................................................. 8
   3.3 Automatic Lamp Shutdown .......................................................................... 8
   3.4 Panel Orientation ......................................................................................... 8
   3.5 Exiting the Data Entry Screen ..................................................................... 8
   3.6 Reference Panel Testing ............................................................................. 9
   3.7 Reader Maintenance ...................................................................................... 9
      3.7.1 Cleaning the Diffuser Filter ................................................................. 9
      3.7.2 Cleaning the Exterior Surfaces of the Reader ....................................... 9
      3.7.3 Bulb Replacement .............................................................................. 9
   3.8 Removing a Jammed Panel .......................................................................... 9
   3.9 Biohazard Warning – Infectious Materials .................................................. 10
   3.10 Electrical Requirements .......................................................................... 10
   3.11 Environmental Requirements .................................................................... 10

4. Getting Started .................................................................................................... 11
   4.1 Launching BD BBL Crystal MIND .............................................................. 11
      4.1.1 Launching from the Windows 7 or 10 Desktop .................................... 11
      4.1.2 Launching from the Oracle VM VirtualBox ......................................... 11
   4.2 Selecting a Language .................................................................................. 12
   4.3 Main Menu ................................................................................................ 12
   4.4 Error Messages .......................................................................................... 13
   4.5 Security ....................................................................................................... 13
      4.5.1 Default User Name and Password ..................................................... 13
      4.5.2 Changing the Password ................................................................. 13
   4.6 Exiting BD BBL Crystal MIND .................................................................. 13
   4.7 Restoring the BD BBL Crystal MIND Database ........................................ 15
5. Data Entry ................................................................................................................... 17
  5.1 Introduction .............................................................................................................. 17
  5.2 Data Entry Overview .............................................................................................. 17
  5.3 Mandatory/Optional Fields ..................................................................................... 18
  5.4 Entering Multiple Panels for a Single Accession .................................................... 18
  5.5 Virtual Panel .......................................................................................................... 19
    5.5.1 Interaction of Virtual Panel and Profile Field ................................................ 19
    5.5.2 Selecting a Panel Type .................................................................................... 19
    5.5.3 Fluorescent Panel Layouts .............................................................................. 20
  5.6 Methods for Entering Panel Reactions .................................................................. 20
    5.6.1 Automatic Reaction Entry ............................................................................. 20
    5.6.2 Profile Field Entry ......................................................................................... 21
    5.6.3 Keyboard Entry ............................................................................................. 21
      5.6.3.1 Entry Order ............................................................................................ 22
      5.6.3.2 Modify Entered Reaction ....................................................................... 22
    5.6.4 Mouse Reaction Entry .................................................................................... 23
      5.6.4.1 Completing a Row or Column ............................................................... 23
      5.6.4.2 Completing the Panel – Complete Panel Button .................................. 24
  5.7 Marking Equivocal Reactions ................................................................................. 25
  5.8 Offline Results Entry .............................................................................................. 25
  5.9 Saving an Accession ............................................................................................... 26
  5.10 Clear Button ......................................................................................................... 26
  5.11 Close Button ........................................................................................................ 26
  5.12 ID Button ............................................................................................................. 26

6. Batch ID ................................................................................................................... 27
  6.1 Introduction ............................................................................................................. 27

7. Review ..................................................................................................................... 29
  7.1 Introduction ............................................................................................................. 29
  7.2 Worklist ................................................................................................................ 29
  7.3 Selecting a Panel in the Worklist .......................................................................... 30
  7.4 Organism Identification Results .......................................................................... 30
    7.4.1 Organism Pushbuttons ............................................................................... 30
    7.4.2 Organism Information Screen ...................................................................... 31
    7.4.3 Previous Nomenclature ............................................................................... 31
  7.5 Supplemental Testing .......................................................................................... 32
  7.6 Statistics and Message Notes .............................................................................. 33
  7.7 Edit/Modify a Panel Profile .................................................................................. 34
  7.8 Resolving Equivocal Results .............................................................................. 35
    7.8.1 (*) Others ....................................................................................................... 36
    7.8.2 Resolve .......................................................................................................... 36
  7.9 Deleting a Panel .................................................................................................... 36
  7.10 Close .................................................................................................................... 36
8. Reports ...................................................................................................................... 37
   8.1 Specimen Report ........................................................................................................ 37
       8.1.1 Printing from the Reports Menu ................................................................. 37
       8.1.2 Printing from Review Screen ................................................................. 37
       8.1.3 Sample Report ....................................................................................... 38
   8.2 Recapitulative Report .......................................................................................... 39
       8.2.1 Sample Report ....................................................................................... 40
9. User Account Setup .................................................................................................... 41
   9.1 Introduction ........................................................................................................ 41
   9.2 Change Password ............................................................................................... 41
   9.3 Account Password ............................................................................................. 42
       9.3.1 Adding a New User Account ................................................................. 42
       9.3.2 Modifying a User Account ....................................................................... 43
       9.3.3 Deleting a User Account ......................................................................... 43
10. Percent Chart ......................................................................................................... 45
    10.1 Introduction .................................................................................................... 45
11. Reference Test ....................................................................................................... 47
    11.1 Introduction .................................................................................................... 47
12. Configuration .......................................................................................................... 49
    12.1 Introduction .................................................................................................... 49
    12.2 Data Review Period ........................................................................................ 49
    12.3 Panel Reaction Entry ..................................................................................... 50
    12.4 Configuring the BD BBL Crystal AutoReader ............................................... 50
    12.5 Configuring a Printer .................................................................................... 53
        12.5.1 Network Printer .................................................................................. 53
        12.5.2 Local Printer ..................................................................................... 54
13. Working with the Keyboard ................................................................................... 55
    13.1 Global Rules .................................................................................................. 55
14. Troubleshooting ..................................................................................................... 57
15. International Contacts ............................................................................................ 63
1 Introduction to BD BBL™ Crystal™ MIND

The BD BBL Crystal MIND System for Microbial Identification is designed to identify clinically significant human pathogens. The purpose of this software is to provide the identification of the unknown organism run in a panel by mathematically interpreting the BD BBL Crystal profile number and off-line test results and evaluating the result against the organisms contained in the appropriate BD BBL Crystal database.

By providing the interpretative component of the BD BBL Crystal ID System in this manner, the user has access to the proper interpretation of all BD BBL Crystal profile numbers. The user has full access to the calculated parameters used in the ID process.

Additionally, a differentiation database is included to assist in resolving those pairs of organisms that occasionally cannot be differentiated on the basis of the profile and off-line tests alone.

1.1 BD BBL Crystal MIND Overview

This software is designed to support the BD BBL Crystal E/NF, Anaerobe, Gram Positive, Rapid Gram Positive, and N/H Identification panels.

The following features are included to optimize the workflow and ease of use:

- Context panel image makes the product more user friendly.
- Keyboard and Mouse Data Entry modes: 2 modes for adaptability.
- Equivocal reaction reading management for more flexibility.
- Batch Identification mode for increased productivity.
- Result review easier to access.
- Reports printed for archive.
- Password security for protection of the panel information.
- Long term storage of information in a database.

1.2 Workflow

There are two workflow paths that you can follow. You can use one or the other or a combination of both. One of the workflows requires the use of a BD BBL Crystal AutoReader, and the other requires a BD BBL Crystal PanelViewer.
The following is an overview of the steps required to enter and identify a Crystal panel

1. Either scan the panel or manually read the panel reactions:
   - If you have an attached BD BBL Crystal AutoReader, scan the panel using the AutoReader. The results are automatically displayed on the Data Entry screen in the virtual panel. Skip to step 2.
   - If you have a manual BD BBL Crystal PanelViewer, read the reactions of the panel using the PanelViewer and record the reactions in the virtual panel on the Data Entry screen.

2. Launch the Batch Identification (ID) process. More than one panel can be identified at the same time. (For details, see section 6.)

3. Review results (organism identifications, statistics, special messages) through the Review screen. An EDIT function allows correction of potential errors while reviewing the ID(s) suggested by the system. (For details, see section 7.)

4. If desired, generate and print reports. (For details, see section 8.)
2 System Requirements and Installation

2.1 System Configuration

To install the BD BBL Crystal MIND software on a Microsoft Windows 7 or 10 system, the following minimal system configuration is required:

- 2 GB RAM
- 3 GB free hard disk space
- Microsoft Windows 7 or 10 (Professional edition or higher)

2.2 Installing BD BBL Crystal MIND

Installing the software on a Windows 7 or 10 system also installs an Oracle VM VirtualBox, which creates an environment for running applications that were built before the introduction of Windows 7 or 10.

NOTE
The following instructions may vary slightly depending on the version of Windows you are running.

1. If BD BBL Crystal MIND is already installed on your computer, back up your database before proceeding with the installation. Copy the file C:\Crystal\Crystal.MDB to another location, such as a USB drive or new folder not under C:\Crystal\.

2. Download the installation file CrystalMIND_V5.05_Win7_10_Installer_V1.3.exe.

3. Temporarily disable any antivirus protection.

4. Locate the downloaded file CrystalMIND_V5.05_Win7_10_Installer_V1.3.exe on your computer and double-click it to begin the installation.

The Crystal MIND - InstallShield Wizard window appears.
Then, a Crystal MIND Installer window indicates that system prerequisites are being checked.

If all prerequisites are met, the installation continues. If all prerequisites are not met, the installation is aborted.

5 When the next Crystal MIND Installer window appears, select the method you will use to read your Crystal panels:

- **Manual Crystal** to use a PanelViewer
- **Auto Crystal** to use an AutoReader

Then, click **OK** to continue.
6 When the VirtualBox configuration begins, the following two windows appear one or more times depending on the system configuration. Click **Install** each time the Windows Security window is displayed.

![Windows Security Window](image1)

After BD BBL Crystal MIND and its supporting components have been installed successfully, the following Crystal MIND Installer window appears.

![Crystal MIND Installer Window](image2)

7 Click the **Close** button.

8 Reenable antivirus protection that was disabled before installation.
If **Manual Crystal** was selected in step 5, skip this step. If **Auto Crystal** was selected in step 5, and your computer communicates with the AutoReader via a serial-to-USB converter cable (because the computer does not have a serial port), perform the following steps:

a. From the **Start** menu of your computer desktop, click **All Programs**, scroll through the list, and locate **Oracle VM VirtualBox**. Click the folder and then click **Oracle VM VirtualBox** to open the Oracle VM VirtualBox Manager.

b. Click **Settings** as indicated by the red arrow in the following picture:

![Oracle VM VirtualBox Manager](image)

The BBL Auto Crystal - Settings window is displayed.

c. Select the **Serial Ports** option in the left pane and clear the **Enable Serial Port** checkbox.

![BBL Auto Crystal - Settings](image)

d. Click the **OK** button to save the changes. Then, exit the Oracle VM VirtualBox Manager.

### 2.2.1 BD Crystal MIND Desktop Icon

When the installation is complete, an icon to launch the software is created on the desktop.

For details about starting BD BBL Crystal MIND and using the software, see section 4. For details about configuring the AutoReader and printers, see section 12.
3 BD BBL Crystal AutoReader

The BD BBL Crystal MIND software can be used with a BD BBL Crystal AutoReader. The AutoReader allows automatic reading of panels instead of manually reading the panels with a BD BBL Crystal PanelViewer (see section 5.6 for details).

CAUTION

Protection provided by this instrument may be impaired if the equipment is used in a manner not consistent with instructions in this manual.

3.1 Setup

3.1.1 Connecting the Power Cable

The BD BBL Crystal AutoReader requires a power cable to be connected. The power cable connects from the back of the AutoReader to the wall outlet.

3.1.2 Connecting the Serial Communications Cable

The BD BBL Crystal MIND software communicates with the AutoReader using a serial/com port. The serial cable connects from the back of the AutoReader to the PC that contains the BD BBL Crystal MIND software.

To connect the AutoReader to the PC, perform the following steps:

1. Connect the larger (25-pin) end of the provided serial cable to the back of the AutoReader in the port labeled DATA.

2. Connect the other end (9-pin) to the serial/com port on the back of your PC.

The serial port is labeled as follows:
For laptops or computers that do not have a serial port, a USB-to-serial converter cable is needed (not supplied with the AutoReader).

To connect the AutoReader to the PC using a converter cable, perform the following steps:

1. Plug the USB end of the converter cable into a USB slot on the PC, and plug the serial end of the converter into the 9-pin end of the AutoReader cable.

2. Plug the other end of the AutoReader cable (25-pin) into the back of the reader.

During installation of the BD BBL Crystal MIND software, the com port setting defaults to 1. If this setting needs to be changed, or if a USB-to-serial converter is being used, see section 12.4 for details about configuring the port.

3.1.3 Power Switch

The power switch is located on the back panel of the Reader.

|   | = Power ON       | O = Power OFF |

3.1.4 Upgrade

If the BD BBL Crystal AutoReader is being replaced, you must shut down the BD BBL Crystal MIND software prior to installing the new reader. Once the new reader is connected, restart the software.

3.2 Warmup Cycle

When powered on, the reader will turn on its internal lamps and begin a warmup cycle that takes 10 minutes to complete.

If an attempt is made to open the drawer (by entering the Data Entry screen), an error message will be displayed indicating that the reader is warming up. The message will indicate the number of minutes and seconds remaining before the warmup cycle is complete.

If you attempt to scan/read a panel during this warm-up cycle, an error message will be displayed indicating that the reader is warming up. The message will indicate the number of minutes and seconds remaining before the warmup cycle is complete.

3.3 Automatic Lamp Shutdown

The reader will automatically turn all internal lamps off after 1 hour of inactivity. The purpose of the shutdown is to increase the lifetime of the internal lamps. If the reader is in the shutdown mode, any attempts to open the drawer of the reader or to scan a panel will transition the reader into the warmup mode. As stated above, the warmup mode will take 10 minutes to complete.

3.4 Panel Orientation

Proper placement of the Crystal panel into the BD BBL Crystal AutoReader is essential for correct organism identification. The label on the Crystal panel should be facing down and pointing towards the front of the drawer. There will be a label on the inside of the drawer indicating where the label of the panel should be placed. The panel label should be directly touching the indicator on the inside of the drawer.

3.5 Exiting the Data Entry Screen

It is highly recommended to exit the Data Entry screen when not reading panels. The drawer of the reader remains open while in the Data Entry screen. This results in the lamps cooling down, which could affect organism identification.
3.6 Reference Panel Testing

A Reference Panel has been provided with your BD BBL Crystal AutoReader. The Reference Panel is used to determine that the AutoReader is properly calibrated. It is recommended that you scan a Reference Panel at least once per month. The Reference Panel should be kept in a protective sleeve such as the one in which the panel was shipped. See section 11 for details.

3.7 Reader Maintenance

3.7.1 Cleaning the Diffuser Filter
The Diffuser Filter is the white glass plate on the bottom of the AutoReader drawer. This filter will need to be cleaned periodically to ensure accurate panel readings. Prior to cleaning the filter, you MUST power the AutoReader off and unplug it from the wall. You can clean it with either a lint-free cloth or lens paper moistened with water or commercial lens cleaning solution.

3.7.2 Cleaning the Exterior Surfaces of the Reader
The external surfaces may be wiped clean with a soft cloth or sponge moistened with water and/or mild detergent. If desired, the outer surfaces can be wiped with a 10:1 dilution of household bleach in water. In all cases, care should be exercised to prevent liquid from entering the AutoReader.

3.7.3 Bulb Replacement
The AutoReader contains two internal lamps, a white light bulb and a UV light bulb. Should either bulb burnout, please call U.S. BD Technical Services to have the AutoReader replaced with a working reader. Lamp replacement should only be performed by qualified personnel, as replacing the lamp without subsequent re-calibration of the reader can cause the system to report inaccurate test results.

NOTE
Do not attempt to open the reader and replace the bulbs. Call BD for assistance.

3.8 Removing a Jammed Panel
If a panel is jammed in the AutoReader, turn the Reader power off and remove the panel. Turn the power back on and rescan the panel.

NOTE
After turning the power back on, the Reader must go through its 10 minute warmup cycle.

CAUTION
Do not attempt to remove a panel with the power on.
3.9 Biohazard Warning – Infectious Materials

Inoculated panels may contain viable pathogenic organisms cultured from the initial specimen. Panels should be handled and disposed of in a manner consistent with regulations and procedures prescribed by local health authorities. Use of gloves is recommended.

3.10 Electrical Requirements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Voltage</td>
<td>100–240 VAC, single phase</td>
</tr>
<tr>
<td>Input Current</td>
<td>0.37 A</td>
</tr>
<tr>
<td>Input Line Frequency</td>
<td>50/60 Hz</td>
</tr>
</tbody>
</table>

3.11 Environmental Requirements

Fluorogenic area

<table>
<thead>
<tr>
<th>Non-Operating Storage</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>-17.8–65.0 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>10–90% relative humidity (non-condensing)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating Conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>18–30 °C</td>
</tr>
<tr>
<td></td>
<td>Microbiological efficacy may be compromised above 40 °C.</td>
</tr>
<tr>
<td>Humidity</td>
<td>15–90% relative humidity (non-condensing)</td>
</tr>
<tr>
<td>Locations</td>
<td>Level surface, no direct sunlight, no direct heat. Typical laboratory lighting (up to 150 foot-candles).</td>
</tr>
<tr>
<td>Altitude</td>
<td>0–2,000 m</td>
</tr>
<tr>
<td>Installation Category II and Pollution Degree 2 as per IEC 664</td>
<td></td>
</tr>
</tbody>
</table>
4 Getting Started

4.1 Launching BD BBL Crystal MIND

4.1.1 Launching from the Windows 7 or 10 Desktop
Launching from the Windows 7 or 10 desktop is the standard method to run BD BBL Crystal MIND. To launch the software, double-click the BD Crystal MIND icon located on the desktop.

Depending on the speed of your system, the software may take a few seconds to start. The Oracle VM VirtualBox will be loaded with BD BBL Crystal MIND launched.

NOTE
If you have a connected AutoReader, see section 12.4 for details about configuring the AutoReader.

4.1.2 Launching from the Oracle VM VirtualBox
The Oracle VM VirtualBox was installed during the BD BBL Crystal MIND installation. When the software is launched from your desktop, the VirtualBox is loaded first. The VirtualBox is running Windows XP to allow the BD BBL Crystal MIND software to function.

If the software is exited, but the VirtualBox is still running, you can relaunch BD BBL Crystal MIND from the VirtualBox by performing one of the following actions:

• Double-click the Crystal MIND icon in the VirtualBox.

• Select Start > All Programs > BBL Crystal MIND > Crystal MIND.
4.2 Selecting a Language

The first time the BD BBL Crystal MIND software is launched, a window is displayed that allows you to select the language in which you want to work.

Select your desired language. You will then be prompted to enter a user name and password.

- The default USERNAME is **BBL Crystal**.
- The default PASSWORD is **BBL**.

Do not change the operating language of the software after it has been selected. Doing so will result in the database containing results in multiple languages.

4.3 Main Menu

The Main program contains the following menus and submenus:

- **File**
  - Exit
- **Data Entry** (Displays a Screen to enter panel reactions)
- **Batch ID** (Launches the ID system to identify organisms on the panels)
- **Review** (Displays a Screen to review panel ID results)
- **Reports** (Sends specified report to the printer)
  - Specimens reports
  - Recapitulative report
- **SetUp** (Adds / Edits system users and passwords)
  - Change Password
  - Account Password
- **Percentage** (Displays a Screen containing the percent charts for all panels)
- **Reference Test** (Displays a Screen to allow running a Reference Panel Test)
4.4 Error Messages

When an error message is displayed on the screen, you can print the message by clicking the Print button.

If an error message occurs for which you need assistance, please print the error message so that a BD Technical Services representative can better assist you.

4.5 Security

4.5.1 Default User Name and Password

Security is available in the BD BBL Crystal MIND software. The security consists of a user name and password that you enter when launching the software. When the product is installed, the default USERNAME is **BBL Crystal** and the default PASSWORD is **BBL**.

4.5.2 Changing the Password

When the software is installed and running, you can change the password. To change the password, you must select the **Setup/Change Password** menu.

When the Change Password screen is displayed, you must:

1. Enter the current password in the **Old Password** field.
2. Enter the new password in the **New Password** field.
3. Enter the new password again in the **New Password Verification** field.

(See section 9 for more details.)

4.6 Exiting BD BBL Crystal MIND

To exit BD BBL Crystal MIND, select **File > Exit** from the BD BBL Crystal MIND menu.

You can keep the VirtualBox running and minimize the window (this is recommended).
If you prefer to exit the VirtualBox:

1. Select **File > Close** from the VirtualBox menu.

2. Select **Save the machine state** and click **OK**.

**NOTE**

Each time the VirtualBox is restarted, any previously connected devices will have to be reconnected by selecting the device from the Devices menu. Devices will not have to be set up again.
4.7 Restoring the BD BBL Crystal MIND Database

To restore a previously backed-up database:

1. Copy the crystal.mdb database to a USB flash drive.
2. Insert the USB flash drive into the USB port of the computer.
3. If the Oracle VM VirtualBox is not already running, start the VirtualBox by double-clicking the **BD Crystal MIND** icon on the host machine. The software will automatically launch. Then, exit BD BBL Crystal MIND.
4. From the VirtualBox window:
   a. Select **Devices > USB**.
   b. Locate the USB flash drive on the list and click it. For example:

   ![USB Drive Selection](image)

   This automatically prepares the USB flash drive for use in the following steps.

   If you are not sure which item is the USB flash drive:
   a. Disconnect the item and view the USB list.
   b. Reconnect the item.
   c. View the list again to determine which item has been added to the list.

   The USB drive is ready for use.

5. Start Windows Explorer by right-clicking the **Start** menu of the VirtualBox and selecting **Explore**.
6. Locate the USB Flash drive in Explorer and click it to open its contents. Then, locate the crystal.mdb database file.
7. Right-click the crystal.mdb database file and select **Copy** from the pop-up menu.
8. Locate and open the C:\Crystal\ folder in Explorer. Locate the crystal.mdb database file and rename it crystal_old.mdb.
9. Right-click and select **Paste** to paste the backed-up copy of the crystal.mdb file into the C:\crystal\ folder.
10. Exit Explorer.
5  Data Entry

5.1  Introduction
To enter a new panel, select the **Data Entry** menu. This displays the Data Entry screen. The Data Entry screen allows you to enter up to seven different panels for an accession. Each panel must be a different panel type.

If you have a BD BBL Crystal AutoReader attached to your PC, a **Scan** button appears on the screen, and the drawer of the AutoReader automatically opens. When the panel is scanned, the biochemical reactions are automatically displayed on the screen.

If you have set up to read your panels manually, the **Scan** button does not appear on the screen, and you have to manually enter the biochemical reactions of the panel after reading the reactions via a BD BBL Crystal PanelViewer.

5.2  Data Entry Overview
To enter results for a panel, follow these steps:

1. Enter the **Accession Number**.
2. Enter an optional **Patient Id** and **Patient Name**.
3. Select a **Panel Type**.
4. Enter the biochemical reactions of the panel, or place the panel in a BD BBL Crystal AutoReader and click the **Scan** button.
5. Enter any required offline test results.
6. Click the **Add** button.
7. To calculate an organism ID and review the ID results for all the newly entered panels, click the **ID** button, then go to the Review screen.
5.3 Mandatory/Optional Fields

- When the screen is displayed, the focus is on the **Accession Number** field. You must enter
  data in this field to save a panel, as it is mandatory. The information is not saved if this field is
  empty.
- There is the option of entering the **Patient Id** and **Patient Name**, but these two fields are not
  mandatory. If you enter a **Patient Id**, you do not have to enter a **Patient Name**. If you enter a
  **Patient Name**, you must enter a **Patient Id**. If the patient already exists in the database,
  when the **Patient Id** is entered and **Enter** is pressed, the **Patient Name** is automatically
  displayed in the corresponding field. When the **Patient Name** is entered, a search of the
  database is not performed for an existing patient, so the **Patient Id** must be entered
  manually.
- All biochemicals of the selected panel must be filled with a positive or negative reaction. The
  information is not saved if the panel is not complete.
- The associated offline test results must be entered as well. The information is not saved if
  offline test results are not entered.

5.4 Entering Multiple Panels for a Single Accession

You have the option to add multiple different panels for the same accession number. Enter the
**Accession Number** and, optionally, **Patient Id** and **Name**. Select one panel type and complete
it by entering all the biochemical reactions. Enter the associated offline test results. Click another
panel type and then complete it. The general information (**Accession Number**, **Patient Id**, 
and/or **Name**) are still displayed on the screen. Follow this process for the different panels for
this accession number.

You can always return to a panel already entered for this accession number (prior to saving) by
clicking the desired panel type, and the results will be displayed on the screen.

**NOTE**

For detailed information on how to perform the preceding steps,
proceed with the following sections.

**NOTE**

You cannot switch from the current panel to another one if the
current panel is not entirely completed. This means the virtual panel
and the offline test results have to be completed. A message is
displayed on the screen if switching is attempted prior to completing
the current panel.
5.5 **Virtual Panel**

The virtual panel is the graphic display in the middle of the screen that shows the biochemical layout of the selected panel marked by columns A through J and rows 4, 2, and 1. When the virtual panel is initially displayed, all biochemical reactions are blank. Positive and negative reactions are filled in the positions of the virtual panel through various methods, which are described in subsequent sections.

5.5.1 **Interaction of Virtual Panel and Profile Field**

The profile field and the virtual panel are interactive. When a position of the virtual panel is filled, the corresponding number is automatically added in the profile field and vice versa. When a figure is added in the profile field, the corresponding sign appears in the virtual panel.

![Virtual Panel Diagram]

5.5.2 **Selecting a Panel Type**

The virtual panel allows the selection of up to seven different panel types.

- **ENF** BBL Crystal Enteric/NF
- **ANR/CDC** BBL Crystal Anaerobe from CDC Blood Agar
- **ANR/SCH** BBL Crystal Anaerobe from Schaedler
- **ANR/ALT** BBL Crystal Anaerobe from Alternate Blood Agars
- **GP** BBL Crystal Gram Positive
- **RGP** BBL Crystal Rapid Gram Positive
- **NH** BBL Crystal Neisseria/Haemophilus

To select a panel type, click the panel abbreviation. To select a panel type using the keyboard, place focus on the panel type section, use the left and right arrow keys to highlight the desired panel, and press **Enter**.
5.5.3 Fluorescent Panel Layouts
There are two basic types of panels, Fluorescent and non-Fluorescent panels. The fluorescent panels have a gray circle on the first row/first column (4A) of the virtual panel (FCT = Fluorescent ConTrol). This position cannot be filled with a sign.

The fluorescent panels are broken into two areas, the Chromogenic area and the Fluorogenic area. The Chromogenic area is shaded in orange with the column numbers in red. The Fluorogenic area is white with the column numbers in black.

5.6 Methods for Entering Panel Reactions
There are four methods of entering positive/negative reactions of the biochemicals on a panel. The following sections describe each of the methods.

5.6.1 Automatic Reaction Entry

NOTE
This method is available only if you have a BD BBL Crystal AutoReader attached to your PC.

If you have an attached BD BBL Crystal AutoReader, place the panel in the AutoReader, select the appropriate panel type on the screen, and click the Scan button. The panel is scanned and the positive and negative reactions are automatically displayed in the virtual panel on the Data Entry screen. You must enter the offline results manually.

NOTE
Any of the following methods can be used to modify the reactions received from the Reader.
5.6.2 Profile Field Entry
If you are manually reading panels, you have the option of entering the panel results by directly entering the profile number in the Profile Number field. As the profile number is entered, the panel reactions are automatically filled in the virtual panel.

After the selection of a panel type, the focus is on the first position (A) of the profile field. Using the keypad, enter the first number of the profile. Focus automatically moves to the next position (B) in the Profile Number field. Continue until all positions have been entered.

To move to a position in the profile number without typing a number, press the Tab key to move forward and press Shift+Tab to move backward within the Profile Number field.

5.6.3 Keyboard Entry
If you are manually reading panels, you have the option of entering the panel results using the plus sign (+) and minus sign (-) keys on your keypad. To enter results using this method, you must select the Keyboard radio button. This option is the default method when the Data Entry screen is entered. To change the default option, see section 12. When the Keyboard option is selected, you cannot use the mouse to enter panel reactions in the virtual panel.

NOTE
If you have a laptop, you may need to press the NumLock key to enable the keypad. The plus sign (+) and minus sign (-) keys on the keypad are the same keys as P and colon (:) for the standard keyboard.

When you have selected the Panel Type of the panel to be entered and the Accession Number has already been entered, focus is moved to the first position of the Profile Number field, and a question mark (?) is displayed on the virtual panel. The position of the question mark (?) depends upon the selected panel and is described below.

If the accession has not been filled, the focus moves to the Accession Number field after the Panel Type has been selected since the Accession field must be entered. If this occurs, enter the Accession Number and press Tab or Enter until focus is on the first position of the Profile Number field.
5.6.3.1 Entry Order

The order in which the panel positions are traversed, as biochemical reactions are entered, is dependent upon whether the panel is fluorescent or non-fluorescent.

Non-Fluorescent Panels

The focus moves from left to right and from top to bottom, as you enter each biochemical reaction on the virtual panel.

![Non-Fluorescent Panels Diagram]

Fluorescent Panels

The focus moves from top to bottom and left to right. The Chromogenic area is completed first, and then the Fluorogenic area is completed.

![Fluorescent Panels Diagram]

5.6.3.2 Modify Entered Reaction

There are two methods of modifying a reaction that has been entered: using the Backspace key or switching to Mouse mode and using the mouse.

Backspace Key

The Backspace key allows you to modify the previous reaction. The focus goes back to the last position entered and erases it. This method is best used when you make a mistake on the last entered reaction.

Using the Mouse

You must select the Mouse Entry option to enable the mouse. Clicking on the result with the mouse makes the reaction change to the opposite value (positive becomes negative and negative becomes positive).

To complete the panel reactions using the keyboard, you must select the Keyboard Entry option again. The focus is placed after the last biochemical entered.
5.6.4 **Mouse Reaction Entry**

If you are manually reading panels, you have the option of entering the panel results with the mouse. Using the mouse to enter biochemical reactions in the virtual panel offers greater flexibility over using the keyboard. In order to enter panel reactions using the mouse, the **Mouse Entry** option must be selected. The **Keyboard Entry** option is the default method when the Data Entry screen is entered. To change the default option, see section 12.

You are not required to enter the reactions in any particular order when using the mouse. Just place the mouse over the panel position to enter and click the left mouse button once to enter a positive result and twice to enter a negative result.

### 5.6.4.1 Completing a Row or Column

An entire row can be completed at the same time by clicking on the row indicator (4, 2, or 1). An entire column can be completed at the same time by clicking on the column indicator (A, B, C, etc.).

![Column indicators]

The following paragraphs describe various ways to complete the column or row:

- If the row or column is completely empty, clicking on the row or column indicator will complete that row or column with plus signs (+).
- If the row or column contains all plus signs (+), then clicking on the row or column indicator will complete that row or column with minus signs (−).
- If the row or column contains all minus signs (−), then clicking on the row or column indicator will complete that row or column with plus signs (+).
- If the row or column contains some plus signs (+) and some minus signs (−), then clicking on the row or column indicator will complete that row or column with all plus signs (+) (converting all minus signs (−) and empty positions to plus signs [+]).
5.6.4.2 Completing the Panel – Complete Panel Button

When the Mouse Entry option is selected, a Complete Panel button is displayed that allows the entire panel to be completed at the same time.

The panel is completed differently depending upon the panel nature: Non-Fluorescent or Fluorescent. The following paragraphs describe various ways to complete the entire panel based on the panel nature when the Complete Panel button is clicked.

Non-Fluorescent Panel

If the entire panel is empty, the following message is displayed.

![Yes, No, Cancel, Print buttons]

Clicking the Yes button fills all the positions with plus signs (+). Clicking the No button fills all the positions with minus signs (-).

- If the panel contains some plus signs (+) and the rest of the positions are empty, all of the empty positions are filled with minus signs (-). The opposite is true as well. If the panel contains some minus signs (-) and the rest of the positions are empty, all of the empty positions are filled with plus signs (+).
- If the panel contains some plus signs (+) and some minus signs (-), an error message is displayed, indicating that the panel cannot be completed using the Complete Panel button.

Fluorescent Panel

Fluorescent panels contain two areas (Fluorogenic or Chromogenic). Each area is completed independently of the other. Each area uses the same rules as described for Non-Fluorescent panels.

- If an area is empty, then a message asking how to complete that area is displayed. Pressing the Yes button fills all the positions with plus signs (+). Pressing the No button fills all the positions with minus signs (-).
- If an area contains some plus signs (+) and the rest of the positions of that area are empty, all of the empty positions will be filled with minus signs (-). The opposite is true as well. If an area contains some minus signs (-) and the rest of the positions of that area are empty, all of the empty positions will be filled with plus signs (+).
- If an area contains some plus signs (+) and some minus signs (-), an error message will be displayed, indicating that the panel cannot be completed using the Complete Panel button.
5.7 **Marking Equivocal Reactions**

If you are unsure if a biochemical reaction is positive or negative, the biochemical can be marked as *equivocal*. You must still give the biochemical a positive or negative result, but it can be marked so that it is visually apparent that the reaction is questionable.

To mark a biochemical as equivocal, first enter the positive or negative result and then click once on the biochemical test name abbreviation. The biochemical test name becomes yellow and highlighted in red. If you are entering reactions using the Keyboard Entry mode, press `Ctrl` and either a plus sign (+) or minus sign (-) while entering the test reactions.

To remove an equivocal mark, click the biochemical test, and the red highlighting will be removed.

The **Profile Number** in the *profile* field is not affected by the equivocal reactions. The *Profile Number* is calculated normally, using the positive and negative reactions.

5.8 **Offline Results Entry**

Offline results must be entered in order to save the panel.

To enter a result for a given offline test, click the result to the left of the box. A cross is displayed on the box, corresponding to this result. This must be done for each offline test.

To enter results for offline tests without using a mouse: after completing the virtual panel with plus sign (+) and minus sign (-) keys, focus is on the first position of the offline result. The arrow keys allow you to switch to the different results for a given offline test. `Tab` and `Enter` allow you to switch to another offline test.

Some offline tests are radio buttons instead of checkboxes. Use the same rules described above to enter the results.

NOTE

Some panel types may require the entry of offline results prior to scanning a panel.
5.9 Saving an Accession

Clicking the **Add** button or pressing **Alt+A** saves an accession and all of its panels to the BD BBL Crystal MIND Database.

Before saving an accession, all the mandatory fields must be completed for each panel (accession number, panel reactions, offline results). If one of the mandatory fields is not complete when the **Add** button is clicked, an error message is displayed, and the information is not saved.

When the **Add** button is clicked, the *...Please wait...* message is displayed on the screen. You must wait until the end of the process to continue to work.

The screen is cleared when the saving is complete, and the focus is placed on the **Accession Number** field.

---

**NOTE**

If the same accession number is saved to the database at different times, the panels of the accession number will not be associated. Since they were entered at different times, they are considered to be two different accession numbers.

5.10 Clear Button

If the **Clear** button is clicked, it clears the screen. A message is displayed asking you to confirm the clear. If you click the **OK** button, the screen is cleared, including all panels entered for the current accession number. You will lose any unsaved data. If you click the **Cancel** button, the screen is not cleared, and the Data Entry screen is re-displayed.

The focus is then on the **Accession Number** field. The Reaction Entry mode (Keyboard or Mouse) remains the same.

5.11 Close Button

If the **Close** button is clicked, the Data Entry screen is closed, and the Main BD BBL Crystal MIND screen is displayed.

If there is unsaved data on the screen, a message is displayed, indicating that there is unsaved data on the screen. If you click the **Yes** button, the Main screen is displayed, and all data on the screen is lost. If you click the **No** button, the data remains on the screen, and the Data Entry screen is re-displayed.

5.12 ID Button

By clicking the **ID** button, the Organism Identification process is started.

It launches the Batch ID process to obtain identifications, statistics, and special messages of all the panels that have not passed through the Batch ID process. (See section 6 for details.)
6 Batch ID

6.1 Introduction

The Batch ID process launches the ID Engine to obtain organism identifications, statistics, and special messages of the panels entered through the Data Entry screen that have not been passed through the Batch ID process. This operation has to be initiated after adding panels in the Data Entry screen in order to view Panel ID Results.

The Batch ID process is active from any screen menu (Main, Data Entry, and Review screens):

or from the ID button on the Data Entry screen:

- In the Data Entry screen, several panels for a given accession can be entered. One or more panels for different accession numbers can also be entered. At any point in time, the Batch ID process can be launched. The Batch ID process does not have to be launched after each Accession Save since the Batch ID process will launch the ID Engine for all panels that have not been identified.
- When the Batch ID process is launched, a message is displayed on the screen. You must wait until the end of the process to continue to work.
7 Review

7.1 Introduction

The Review screen displays the panel results that were generated by the Batch ID process. The screen is divided in 2 main sections:

- At the top of the screen, all the panels that have not been printed and have been Batch ID processed are displayed in a scrollable worklist.
- The remaining portion of the screen contains the results of the panel selected in the worklist. The results include: Identifications with statistics (Biotype Validity and Confidence factor), statistics, and/or message notes.

When the user enters in this screen, the focus is on the first line of the worklist if there is at least one panel displayed.

7.2 Worklist

The worklist displays all the panels that have not been printed and have passed through the Batch ID process. By default, the worklist is sorted by patient name. You have the option of changing the default sorting of patient name to accession number by clicking the corresponding radio button below the worklist.
The worklist displays the following information:

- The panel abbreviation
- An asterisk if a panel has equivocal results
- The profile number
- The patient name (if it exists)
- The accession number

If you would like to view panels that have already been printed, you must check the box, **Display the Profiles already Printed**, which is located below the worklist. Panels that have not been printed are removed from the list when this checkbox is selected.

The worklist displays, by default, the panels of the last 30 days. You may change this period in the Crystal.ini file and replace 30 with the desired number of days (see section 12 for details).

### 7.3 Selecting a Panel in the Worklist

To select a panel in the worklist, use the up and down arrow keys or click the desired panel. Selecting a panel highlights the entire panel line in the worklist.

Each time a panel line is highlighted, the results of the selected panel are automatically displayed on the bottom portion of the screen.

### 7.4 Organism Identification Results

The bottom portion of the screen displays the organism identification (up to three organisms), the Biotype Validity, Confidence Value, and Special Messages.

#### 7.4.1 Organism Pushbuttons

Each organism name acts as a button. When you click one of the buttons or enter the number displayed between [square brackets], a screen is displayed, containing additional information about the identification. The following section describes the content of this screen.
7.4.2 Organism Information Screen
The following is a description of the screen that is displayed when an organism button is clicked.

- The first section contains Notes about the organism. There are reference numbers displayed at the beginning of the Notes. The reference numbers (2 3 5) refer to the bibliography displayed at the end of the list. In the example, the reference numbers are 2, 3 and 5. At the end of the list, the 3 bibliographies are specified.

- If the organism nomenclature has changed, the next section displays the previous nomenclature. The nomenclature displayed on the Review screen is the new one. The previous nomenclature is displayed on the Organism Information screen.

- If there are atypical results for some of the biochemical tests, the next section, named *Atypical reactions for this organism in the system* is displayed. It contains all the biochemical tests for which there are atypical results, and the obtained results (+ or -).

- To return to the Review screen, click the **Review** button.

7.4.3 Previous Nomenclature
If an organism pushbutton is surrounded in red, it indicates that the organism nomenclature has changed since the previous version of BD BBL Crystal MIND.

The nomenclature displayed on the Review screen is the new one. The previous nomenclature is displayed on the Organism Information screen.
7.5 Supplemental Testing

Clicking the **Sup. Test** button displays the Differentiation Database screen where the organisms identified for the current panel are displayed with their expected behavior on additional supplemental testing. The numbers displayed on this screen represent the percent positive.

You can choose to display all tests or only the meaningful tests, (i.e., the tests for which there are clear pos/neg results for the bacteria under consideration) by clicking the following button.

You can obtain supplementary test information even if the current panel did not produce an identification. In this case, the supplementary tests are displayed for all organisms.

A **Please Wait** message is displayed on the screen while waiting for the supplementary tests screen to display the results.

You can obtain more test results with all the organisms by selecting the **All Organisms** checkbox.

The meanings of each biochemical test and each result are displayed at the bottom of the screen in a Description of the test Codes and Results table. It is sorted in alphabetical order.

The **Close** button returns you to the Review screen.
7.6 **Statistics and Message Notes**

Below the **Organism Results** section, additional information is displayed. Up to two additional sections can be displayed based on the identification results (**Statistics**, **Message**, or **Error** section).

The **Statistics** section gives comments about the reliability of the confidence value.

<table>
<thead>
<tr>
<th>Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>TheCrystalIDReportisbasedonthesestatistics.Choosinganorganismonthebasisofthesestatisticsisnotherecommended.</td>
</tr>
</tbody>
</table>

The confidence value is the degree of certainty for that identification. A value of 1.0 would indicate 100% certainty. The statistic **Biotype Validity** is a measure of how perfect a match is between your result and a hypothetical "best fit" profile number. The larger the value, the worse the agreement is between your profile and the profile for the listed organism or group. The direct use of these statistics to report identifications is not part of the BD BBL Crystal Identification System. Values are displayed for information only. Relatively close values should be considered equivalent (1000 is approximately as meaningful as 5000, for example).

The **Message** section gives comments about the final results. Some organisms display additional information about the organism(s) in the Message box.

<table>
<thead>
<tr>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>TheCrystalIDSystemreportsthesechoices.Supplementaltestingisrecommended.</td>
</tr>
</tbody>
</table>

The **Error** section is displayed instead of the **Message** section if a value higher than 3 has been entered as the first digit of a fluorescent panel profile number. The section is displayed in red, indicating that the panel cannot be calculated.

<table>
<thead>
<tr>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>ThisCrystalprofileindicatesapositiveresultonthefluorescentcontrol.Anegativeresultisexpected.CrystalcannotcalculatelandID.</td>
</tr>
</tbody>
</table>
7.7 Edit/Modify a Panel Profile

It is possible to correct potential errors while reviewing the Identification(s) suggested by the system.

NOTE
The Edit feature is not available if the desired panel has one or more equivocal results. The equivocal results must be resolved before the Edit feature is enabled. See section 7.8 for information on resolving equivocal results.

To edit a panel, click the **Edit** button, and the Data Entry screen is displayed with the selected panel on the screen.

You may now modify the biochemical reactions and the offline tests of the current panel. At this time, you may also enter equivocal results. Only the selected panel from the Review screen can be modified. The associated panels can only be modified by selecting each panel individually in the Review screen and then clicking the **Edit** button.

When you have made all the changes, click the **Modify** button to save the panel. The Batch ID process is automatically re-launched and will give new identifications, and Statistics for the given panel.

To review the new identification results for the modified panel, you must select the Review menu item at the top of the screen to return to the Review screen. Now, you must re-select the desired panel in the worklist.
7.8 Resolving Equivocal Results

The panels that have equivocal results are indicated in the worklist by an asterisk (*) after the panel abbreviation.

When a panel with equivocal reactions is highlighted in the worklist, the attached results are displayed in the organism section (just like panels without equivocal results).

When a panel with equivocal results is selected in the worklist, two additional buttons appear on the left of the screen: (*) Others and Resolve. Their use is described in the sections that follow.
7.8.1 (*) Others

The (*) Others button allows you to display the current profile and the other possible profiles based on selecting the opposite reaction for each of the equivocal biochemicals. When you click the button, the current worklist is cleared and is replaced with all the possible profile numbers for the current panel.

All the possibilities have an asterisk (*) following the panel abbreviation except for the current profile.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENF</td>
<td>5664646051</td>
</tr>
<tr>
<td>ENF</td>
<td>562446051</td>
</tr>
<tr>
<td>ENF</td>
<td>5664646251</td>
</tr>
<tr>
<td>ENF</td>
<td>562446251</td>
</tr>
</tbody>
</table>

# of combinations based on the # of equivocal biochemicals:
- 1 equivocal biochemical ➔ 2 different combinations
- 2 equivocal biochemicals ➔ 4 different combinations
- 3 equivocal biochemicals ➔ 8 different combinations

As you select each profile in the list, the Organism identification results for that profile appear. The next step is to select a profile for this panel or to cancel the operation. The following describes the three buttons that are available:

- **Resolve** – Resolves the panel by selecting the highlighted profile as the final result for the panel. The new results are saved to the database and all equivocal marks are removed from the panel.
- **Cancel** – Returns to the previous Review screen with all the original panels displayed in the worklist. The panel remains unchanged and still has equivocal results.
- **Sup Test** – Displays supplemental testing results.

7.8.2 Resolve

If you choose the original profile (the one displayed in the initial worklist), you have to highlight the panel line and press the Resolve button to resolve the equivocal biochemicals. The (*) Others and Resolve buttons are removed from the screen once the highlighted panel has been resolved. The asterisk after the panel abbreviation for this panel in the worklist is also removed.

7.9 Deleting a Panel

If the Delete button is clicked, a message is displayed on the screen, asking to confirm the deletion. If you answer Yes, the selected panel is deleted from the database.

A panel can be deleted with or without equivocal test results.

If all panels attached to an accession number are deleted, the accession number is deleted from the database. If all accession numbers attached to a patient are deleted, the patient is deleted from the database.

7.10 Close

If the Close button is clicked, the Review screen is closed and the main BD BBL Crystal MIND screen is displayed.
8 Reports

8.1 Specimen Report

The Specimen Report contains panel results for all panels associated to the accession (that were entered at the same time) or for a single panel. Each panel of the specimen is printed on a separate page.

NOTE
When a panel has been printed, it is removed from the Worklist on the Review screen. Make sure that the printer is turned on and has paper prior to printing a Specimen Report. If the printer is turned off, out of paper, or some other technical difficulty has occurred, the panel is still assumed to be printed and will be removed from the Worklist. To be able to reprint the panel, you must select the Display the Profiles already Printed checkbox.

This displays all the panels in the database that have already been printed.

The Specimen Report can be generated two ways: from the Reports Menu or through the Print button on the Review screen. The two printing methods are described below.

8.1.1 Printing from the Reports Menu

To print the Specimen Report through the Reports menu, click Reports and then click Specimen Report. This prints all specimens that have passed through the Batch ID process and have not yet been printed.

8.1.2 Printing from Review Screen

To print the Specimen Report through the Review screen, select a panel in the worklist and then click the Print button. Only the selected panel is printed. Note that panels related to the selected panel are not printed. (When printing from the Reports menu, related panels are printed.)
8.1.3 Sample Report

The report provides the following data:

- A Report Header with the current date and Report title.
- A Specimen Header containing the Accession number, Patient Id, and Patient Name.
- A Panel Results Section containing the Profile number, Panel Type, Offline Test Results, Organism Id(s) with corresponding Biotype and Confidence factor, and messages.
- If there is more than one identified organism, then supplemental test information is given for each of the identified organisms to help you choose a supplemental test to determine a final identification for the panel. An area is provided that enables you to record the results of any supplemental tests that you may have run, as well as an area to record the Final ID.
- An Atypical Reaction section, which displays the expected reaction for biochemicals that deviated from the expected reaction.
## 8.2 Recapitulative Report

The Recapitulative Report is a summary of all the panels that received organism results within a specified date range. A specimen that has not passed through the Batch ID process does not have any of its panels included in the Recapitulative Report.

The report is printed by selecting the **Report** menu from the **Main** menu and then selecting **Recapitulative Report**. When you select the report, you are prompted for a start and end date. The date range defaults to the current day. Click the **OK** button, and the report is sent to the printer.

Refer to section 14 if the report is not printed.

<table>
<thead>
<tr>
<th>From</th>
<th>10/28/2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>10/28/2010</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td></td>
</tr>
</tbody>
</table>
8.2.1 Sample Report

The report provides the following data:

- A header with the report title, the selected date range, and the current date.
- For each profile:
  Accession number
  Patient name
  Profile and panel name
  Offline Test results (Oxydase, Indole, etc.)
  Identifications with the corresponding Confidence factor and Biotype. An exclamation mark (!) indicates that there is an associated Message Taxon that can be viewed in the Specimen Report or Review display.
9 User Account Setup

9.1 Introduction

The Setup menu enables you to add/modify user accounts in the system and modify the passwords of existing user accounts. To run the BD BBL Crystal MIND software, you must have a user account defined in the system.

The default user account is the following:

**Username:** BBL Crystal  
**Password:** BBL

There are two levels of account security: Technologist and Administrator. If you are logged into the system under an account that has a Technologist security level, then you do not have access to the Account Password menu item.

9.2 Change Password

This menu item is accessible for all users and enables you to change your password for the current account that you are logged under.

To change your password, enter the current password in the Old Password field. Enter the new password in the New Password field. For confirmation, enter the new password again in the New Password Verification field.

When you access the screen, the OK button is disabled. It becomes active when you have completed all three fields. You can cancel your changes by clicking the Cancel button.

When the OK button is clicked, if the old password is not correct, or if the new password does not match the value specified in the New Password Verification field, an error message is displayed, and the change does not take place.
9.3 **Account Password**

This menu item is accessed by clicking the **Setup** menu and then clicking **Account Password**. It is accessible only for a user with an Administrator security level. It may be used to add, edit, or delete user accounts.

When entering this screen, the list of all users with their respective security level (Administrator or Technologist) is displayed.

![Security Account Setup](image)

### 9.3.1 Adding a New User Account

To add a new user, click the **Add** button. A window is displayed where you need to enter the **Last** AND **First** name of the new user. Enter up to 24 alphanumeric characters for the **Last** name and up to 25 characters for the **First** name.

![Add User Window](image)

You must choose the user's security level by clicking the **Level 1 (Administrator)** or **Level 2 (Technologist)** radio button.
Click the **Save** button to add the new user to the database. If all fields are not completed, an error message is displayed, informing that the saving cannot take place.

If you want to cancel the addition of the new user, click the **Cancel** button, and the Main screen is displayed.

### NOTE

Each username MUST be unique. If not, an error message is displayed.

#### 9.3.2 Modifying a User Account

You must first select a user account in the list on the Account Password screen. Now, click the **Edit** button to display the account information for the selected user.

This screen functions as described in section 9.3.1 for adding a new user account.

If the user of the account that is being modified has forgotten his/her password, select the **Reset Password to Last Name** checkbox to reset the password to the user's last name. When the user logs in the next time, they can change the password through the **Change Password** option.

#### 9.3.3 Deleting a User Account

To delete a user account, you must first select a user account in the list on the Account Password screen. Now, click the **Delete** button.

A message is displayed, asking you to confirm or cancel the deletion of the selected user.

### NOTE

It is impossible to delete the current logged on user. An error message is displayed if this is attempted.
10 Percent Chart

10.1 Introduction

The Percent Chart is a *display only* informational chart that lists the percentages of each biochemical for each organism. The numbers displayed in the chart represent the percentage of strains positive for the tested biochemical in the BD BBL Crystal Database.

The menu option to display the Percent Chart is available in any screen.
11 Reference Test

11.1 Introduction

To ensure that the AutoReader is correctly calibrated, you must periodically read a Reference Panel in the AutoReader. The Reference Panel is provided with the purchase of your BD BBL Crystal AutoReader. Scanning the Reference Panel in the AutoReader provides either a Pass or Fail status.

To scan the Reference Panel, select the Reference Test menu item from either the Main menu, the Data Entry menu, or the Review menu.

The AutoReader drawer automatically opens, and a screen is displayed, instructing you to place the Reference Panel in the AutoReader. Once you have placed the panel in the AutoReader, click the Scan button to initiate the scanning process. When the scan of the panel is complete, a message appears that indicates the success or failure of the Reference Panel Test. Regardless of the test status, you can remove the panel from the AutoReader and then click the Close button to exit the screen. Upon exiting, the AutoReader drawer automatically closes, and you are returned to the Main screen.

If the Reference Panel passed the test, you can continue to use your AutoReader. If the Reference Panel failed the test, you must contact BD Technical Service for assistance.

NOTE
Do not continue using the AutoReader if the reference panel test failed. Please contact BD Technical Service.
12 Configuration

12.1 Introduction

The system has four configuration options that can be modified via the MIND Setup icon in the BBL Crystal MIND program group.

The four available configuration options are:

- Data Review Period
- Panel Reaction Entry – Mouse vs. Keyboard
- Communications Port for the BD BBL Crystal AutoReader
- Printer – Network or Local

12.2 Data Review Period

The panel data stored in the database is never deleted. You do have the option, however, to limit the number of panels that are displayed in the Review screen (when the checkbox Display the Panels already Printed is selected). To limit the number of panels that are displayed, you can set a parameter that indicates the number of days prior to the current date to keep active.

The default period is 30 days. This number can be changed to any number of days that you desire. Note, however, if this number is too large, the Worklist in the Review screen may be truncated. You will be notified if the list is truncated. If this parameter is set to 0, the data displayed in the worklist is the data for the current day only. If the parameter is set to 1, the data displayed is the data of yesterday and today.

To modify the default setting, exit the BD BBL Crystal MIND software and double-click the MIND Setup icon. This automatically opens the configuration file crystal.ini in a text editor. Perform the following steps:

1. Use your arrows keys to move to the section [Setup].
2. Under the [Setup] section is the configuration setting Periode.
3. Place your cursor at the end of the Periode line.
4. Change the default number (30) to the desired number.
5. If this is the only configuration option that you want to change, then follow the steps below, otherwise proceed to the appropriate section in this manual to modify another configuration option.
6. Click the File menu and select Save.
7. Click the File menu again and select Exit.
12.3 Panel Reaction Entry

When entering positive/negative reactions in the virtual panel on the Data Entry screen, you have two options of data entry: Keyboard or Mouse. When the Data Entry screen is entered, the default option is Keyboard. You can change the setting while in the Data Entry screen by clicking the appropriate radio button. Each time the Data Entry screen is entered, the default setting of Keyboard is always selected.

To modify the default setting to Mouse, exit the BD BBL Crystal MIND software and click the MIND Setup icon. This automatically opens the configuration file crystal.ini in a text editor. Perform the following steps:

1. Use your arrows keys to move to the section [Setup].
2. Under the [Setup] section is the configuration setting Keyboard.
3. Place your cursor at the end of the Keyboard line.
4. Change the default setting of False to True.
5. If this is the only configuration option that you want to change, then follow the steps below, otherwise proceed to the appropriate section in this manual to modify another configuration option.
6. Click on the File menu and select Save.
7. Click on the File menu again and select Exit.

12.4 Configuring the BD BBL Crystal AutoReader

Depending on the ports available on your computer, either you will use a direct connection to a serial port on the computer or, in the case of no serial port, you will connect to a USB port on your computer via a serial-to-USB cable.

If you are using a USB port to communicate to the AutoReader, perform the following steps to configure a USB port within the VirtualBox:

1. Make sure you know name of the driver for the serial-to-USB cable, which will be needed to configure the USB port for communications with the AutoReader.
2. Copy the driver to a USB flash drive and save it for a future step.
3. If the VirtualBox is not already running:
   a. Launch BD BBL Crystal MIND by double-clicking the icon that was created on your desktop during installation.
4. After the VM loads, BD BBL Crystal MIND will launch and display the language selection window.
   b. Click the Exit button to exit BD BBL Crystal MIND. If you have already selected a language, error 68 (Device unavailable) is displayed. Click the OK button to exit.
   4. Insert the USB flash drive containing the serial-to-USB driver into a USB port.
5 From the Oracle VM VirtualBox window:
   a Select **Devices > USB**.
   b Locate the USB flash drive from the list and click it. For example:

   ![USB Flash Drive Selection](image.png)

   This automatically prepares the USB flash drive for use in the following steps.

   If you are not sure which item is the USB flash drive:
   a Disconnect the item and view the USB list.
   b Reconnect the item.
   c View the list again to determine which item has been added to the list.

6 Connect the AutoReader to the computer by inserting the serial-to-USB cable into a USB port on the computer.

7 From the Oracle VM VirtualBox window:
   a Select **Devices > USB**.
   b Locate the serial-to-USB adapter connection in the list and click it.

   ![Found New Hardware Wizard](image.png)

   The **Devices** menu closes, and the Found New Hardware Wizard window appears.
8 Select **No, not this time**, and click the **Next** button. The following Found New Hardware Wizard window appears.

![Found New Hardware Wizard](image)

9 Select **Install from a list or specific location (Advanced)** and click the **Next** button. The following Found New Hardware Wizard window appears.

![Found New Hardware Wizard](image)

10 Clear the **Search removable media (floppy, CD ROM...)** checkbox, select the **Include this location in the search** checkbox, and click the **Browse** button.

11 Under **Browse**, locate the USB flash drive, and select the location on the drive that contains the serial-to-USB driver. Then, click the **OK** button.

12 Click the **Next** button. The driver is installed.

13 Click the **Finish** button.
During the installation of BD BBL Crystal MIND, the com port setting for communicating to the AutoReader defaults to 1. Depending on your specific computer, this setting varies. Try to launch BD BBL Crystal MIND (see section 4.1.2). If error 68 (Device unavailable) occurs, perform the following steps to determine the correct setting:

1. From the VirtualBox, select **Start > All Programs > BBL Crystal MIND > MIND Setup**. This opens a text file containing BD BBL Crystal MIND settings.
2. Scroll to the bottom of the file and change the **CommPort** setting to the next number (for example, 2).
3. Save and close the file.
4. Try to launch BD BBL Crystal MIND again. If error 68 occurs again, repeat steps 1–3, incrementing the com port number until the correct setting is determined.

The AutoReader is now ready to be used in BD BBL Crystal MIND. Because the VirtualBox is already open, follow the steps in section 4.1.2 to launch BD BBL Crystal MIND.

## 12.5 Configuring a Printer

If there is a need to print reports, a printer needs to be configured.

### 12.5.1 Network Printer

To determine the port and add the desired printer, perform the following steps:

1. On the host PC (not the VirtualBox), go to **Devices and Printers**.
2. Locate the desired printer.
3. Right-click the printer icon and select **Printer properties**.
4. Click the **Ports** tab.
5. Locate the selected printer in the list of ports. The port checkbox will be selected. Note the port number, which will be similar to 10.3.19.321.
6. Exit the Printer Properties and Devices and Printers windows.
7. If the VirtualBox is not already running, double-click the **BD Crystal MIND** icon from your host PC to start the VirtualBox, and then exit the BD BBL Crystal MIND software after the VirtualBox has been launched.
8. In the VirtualBox, select **Start Menu > Printers and Faxes**.
9. Click **Add a printer** (under **Printer Tasks** on left side of the display).
10. Click the **Next** button.
11. Select the **Local printer attached to this computer** checkbox and clear the **Automatically detect and install my Plug and Play printer** checkbox. Click the **Next** button.
12. Select **Create a new port** and then **Standard TCP/IP Port** from the drop-down box.
13. Click the **Next** button.
14. When the Add Standard TCP/IP Printer Port Wizard appears, click the **Next** button.
15. Enter the port number (determined in step 5) in the **Printer Name or IP Address** field.
16. Click the **Next** button and then the **Finish** button. The Add Printer Wizard appears.
17. Select the manufacturer of the printer from the list on the left, and then select the printer on the right that most closely resembles the desired printer (or use **Have Disk** if you have the driver on USB or CD-ROM).
18 Click the **Next** button.

   The **Printer** name is automatically filled in, but you may change it.

19 Click the **Next** button.

20 To print a test page, accept the **Yes** default, and click the **Next** button.

21 Click the **Finish** button.

### 12.5.2 Local Printer

1 If the VirtualBox is not already running, double-click the **BD Crystal MIND** icon from your host PC to start the VirtualBox, and then exit the BD BBL Crystal MIND software after the VirtualBox has been launched.

2 Install the printer driver of the local printer on the VirtualBox by inserting the CD-ROM or USB flash drive containing the driver.

3 Click the **Devices** menu.

4 Do one of the following:
   - If the driver is located on a CD-ROM, click the **Optical Drives** option and select the **Host CD** drive. This enables access to the CD-ROM drive in the following steps.
   - If the driver is located on a USB flash drive, click the **USB** option that displays the list of devices connected to the host PC. Locate and click the USB flash drive that contains the driver. This enables access to the flash drive in the following steps.

   It may take about a minute to connect the USB. Indications pop up on the lower-right side of the VirtualBox.

5 Click the **Devices** menu again, and select **USB**. Click the **USB** printer connected to the host PC. This starts to load the printer driver onto your VirtualBox. The Found New Hardware Wizard appears.

6 Select **No, not this time**, and click the **Next** button. The next Found New Hardware Wizard window appears.

7 Select **Install from a list or specific location (Advanced)**, and click the **Next** button. The next Found New Hardware Wizard window appears.

8 Clear the **Search removable media (floppy, CD ROM...)** checkbox, select the **Include this location in the search** checkbox, and click the **Browse** button.

9 Under **Browse**, locate the USB flash drive or CD-ROM and select the location that contains the printer driver. Then, click the **OK** button.

10 Click the **Next** button. The driver is installed.

11 After the driver has been installed, click the **Finish** button. The printer will be installed and selected as the default printer.
13 Working with the Keyboard

13.1 Global Rules

The BD BBL Crystal MIND software can be operated via just the use of the keyboard. There are global keyboard rules which apply to all screens:

To activate a column menu

There is one underlined letter in the menu option. Use Alt+X (where X is the underlined letter) to view the column menu.

To activate an option in the column menu

There is one underlined letter for each option under the menu. Press the X (where X is the underlined letter) to activate the option.

To activate a pushbutton

There is one underlined letter in the name of the push button. Use Alt+X (where X is the underlined letter) to activate the button.

To select a checkbox

When the focus is on the label of the required checkbox, press the spacebar to select the checkbox. An X appears in the box. To clear it, press the spacebar again.

To move through the fields

Use Tab to move forward from field to field.

Use Shift+Tab to move backwards from field to field.

To select a radio button (Keyboard/Mouse, Indole, etc.)

Use Tab to go to the desired field.

Use the up and down arrow keys to select the desired radio button.

To move through the push buttons

When the focus is on a pushbutton, use the up and down arrow keys to highlight the desired pushbutton.

Press Enter to activate it.

You can also use Alt+X to access the button directly.

To move through items in a scrollable list (Review worklist, User Accounts list, etc.)

Use the up and down arrow keys to go through the list. The selected line is highlighted.
# 14 Troubleshooting

The following table describes problems that can occur during the operation of the BD BBL Crystal MIND software. If you need further assistance, contact your local BD representative (see section 15).

## NOTE

In the **Issue/Message Text** column, non-italicized text describes the issue, and *italicized text* displays the message text.

<table>
<thead>
<tr>
<th>Message Index</th>
<th>Issue/Message Text</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>rc-5640</td>
<td>VirtualBox Error: Error In supR3Hardened WinReSpawn</td>
<td>This error can occur when launching BD BBL Crystal MIND. You do <em>not</em> need to reinstall the software. Click OK on the error message and relaunch the software.</td>
</tr>
<tr>
<td></td>
<td>Some panels are not being displayed on the Review screen.</td>
<td>The BD BBL Crystal MIND system was designed to show only a default of the last 30 days of panels. This value can be increased. See section 12.2 for information about how to increase the default setting.</td>
</tr>
<tr>
<td></td>
<td>Data is not being printed in the Recapitulative Report.</td>
<td>The short date setup for your computer must have a four-digit year format. Either refer to the system help on your computer for information about changing this setting or call BD for assistance. The date range of this report requires a four-digit year to be entered. For example, you must enter 11/13/2018 instead of 11/13/18.</td>
</tr>
<tr>
<td></td>
<td>The VirtualBox is asking for a password.</td>
<td>When the VirtualBox goes to sleep or the user is logged off, the user needs to log back on. The User name field is defaulted to Administrator. Leave the password field blank and click the OK button.</td>
</tr>
<tr>
<td>Message Index</td>
<td>Issue/Message Text</td>
<td>Resolution</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|               | The VirtualBox will not load.      | Several errors can occur when attempting to start the VirtualBox by clicking the **BD Crystal MIND** icon from the host machine. Errors that can occur include:  
  • VirtualBox Extension Pack error  
  • Windows XP license activation error  
  • One or more supporting files may be corrupted error  
  • BD BBL Crystal MIND is not installed properly error  
  These errors typically indicate that BD BBL Crystal MIND and the VirtualBox were not installed properly, most likely because antivirus protection was enabled. Uninstall BD BBL Crystal MIND via the Windows control panel, disable all antivirus protection, reinstall BD BBL Crystal MIND, and then reenable antivirus protection. For details, refer to the installation instructions in section 2.2. |
|               | The BD BBL Crystal MIND Installation fails. | The installation can fail for multiple reasons:  
  • The user does not have administrator rights.  
  • The prerequisites have not been met. Refer to section 2.1.  
  • XP Mode can not already be installed and must be uninstalled before attempting the new installer.  
  • An Oracle VirtualBox version other than 5.0.40 is already installed. To avoid conflict, uninstall all other versions.  
  • The error **One or more supporting files may be corrupted** can occur if antivirus protection is enabled. Disable prior to installation and then reenable the antivirus protection.  
  • The error **Crystal MIND is not installed properly** can occur if antivirus protection is enabled. Disable prior to installation and then reenable the antivirus protection. |
<table>
<thead>
<tr>
<th>Message Index</th>
<th>Issue/Message Text</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>68</td>
<td>Device unavailable</td>
<td>The reader may not be turned on or is not connected to the correct com port.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Turn on the power on the reader back panel. Verify the connection between the com port and the serial cable. The proper com port may not be specified in the BD BBL Crystal MIND configuration file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to section 12.4 for information about how to configure the AutoReader.</td>
</tr>
<tr>
<td>14</td>
<td>There are too many records to display in the list. The list of displayed records will be truncated.</td>
<td>This occurs when attempting to view results in the Review module and the number of panels exceeds the maximum number of panels to display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Printing a Specimen Report will clear the list and make room for new panel results. Refer to section 8.1 for information about printing a Specimen Report.</td>
</tr>
<tr>
<td>26</td>
<td>An error occurred while launching the batch identification program…</td>
<td>This error can occur when clicking Batch ID or the ID button. The ID Engine returned an error to BD BBL Crystal MIND. Exit BD BBL Crystal MIND before proceeding with possible resolutions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Run the Repair_Compress Database Utility in the Crystal MIND program group (Start &gt; All Programs &gt; BBL Crystal Mind &gt; Repair_Compress DB). Try running BD BBL Crystal MIND again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the error persists, use Windows Explorer or File Manager to copy the following database files from C:\crystal\database to C:\crystal:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Taxonomy.mdb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Core_id.mdb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Glue.mdb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Try running BD BBL Crystal MIND again. If the error persists, contact BD for assistance.</td>
</tr>
<tr>
<td>72</td>
<td>The database of the ID engine is corrupt, the application will terminate…</td>
<td>This error can occur when:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clicking Batch ID or the ID button, or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Starting the BD BBL Crystal MIND software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The ID Engine returned an error to BD BBL Crystal MIND.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Follow the resolution for preceding error 26.</td>
</tr>
<tr>
<td>Message Index</td>
<td>Issue/Message Text</td>
<td>Resolution</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>------------</td>
</tr>
<tr>
<td>75</td>
<td>An invalid date was entered…</td>
<td>Use the short date format configured in your Windows control panel for Date Format. You must use a forward slash (/) to separate month, day, and year.</td>
</tr>
<tr>
<td>81</td>
<td>A timeout has occurred waiting for the AutoReader to respond…</td>
<td>The reader may not be turned on or is not connected to the correct com port. Turn on the power on the reader back panel. Verify the connection between the com port and the serial cable. The proper com port may not be specified in the BD BBL Crystal MIND configuration file. Refer to section 12.4 for information about changing the com port setting in the BD BBL Crystal MIND configuration file. The computer may need to be rebooted after the initial configuration of the AutoReader.</td>
</tr>
<tr>
<td>83</td>
<td>The panel readings received from the AutoReader were corrupted. Please re-scan the panel…</td>
<td>This message is displayed when the readings were corrupted when sent from the AutoReader to the BD BBL Crystal MIND PC. Rescanning the panel should correct the problem.</td>
</tr>
<tr>
<td>91</td>
<td>The Reference test has failed</td>
<td>The Reference test failed. The failure reason appears at the end of the message. • If the words Visible Failure precede a set of numbers, then the white lamp failed and needs to be replaced. • If the words UV Ref Values precede a set of numbers, then the UV lamp failed and needs to be replaced. • If the lamp is too new and should not be failing at this point, send the BD BBL Crystal MIND error log for evaluation.</td>
</tr>
<tr>
<td>10007</td>
<td>The UV bulb on the reader has FAILED and must be replaced by a Becton Dickinson Service Representative. Panels cannot be read by the Crystal AutoReader until the bulb has been replaced…</td>
<td>This message occurs when the Source Monitor readings from reading a regular panel are out of range. The UV bulb needs to be replaced. Contact BD for assistance.</td>
</tr>
<tr>
<td>Message Index</td>
<td>Issue/Message Text</td>
<td>Resolution</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>10008</td>
<td>The UV control well has readings out of range. Possible causes for this panel error are the following: 1. Laboratory temperature outside range of 64.4 °F – 89.6 °F. 2. A bubble in the control well (location 4A). 3. The UV bulb on the AutoReader has failed.</td>
<td>This message occurs when the UV Control well on the panel has a value outside an acceptable range. Verify that the laboratory temperature is within the required range of 64.4 °F and 89.6 °F. Verify that there are no bubbles in the control well (location 4A) of the panel. If any of the preceding problems exist, a new panel must be used. If the error persists, the UV bulb may need to be replaced. Contact BD for assistance.</td>
</tr>
<tr>
<td>10009</td>
<td>The UV control well has readings that are almost out of range. Please check the control well (Location 4A) for bubbles. The UV bulb on the reader may need to be replaced by a Becton Dickinson Service Representative. Your results from your reader are VALID, but you must contact BD for assistance…</td>
<td>This message occurs when the Source Monitor readings from reading a regular panel are almost out of range. The UV bulb needs to be replaced. Contact BD for assistance.</td>
</tr>
<tr>
<td>100010</td>
<td>The white bulb on the reader needs to be replaced by a Becton Dickinson Service Representative…</td>
<td>This message occurs when the readings from a regular panel do not have enough variability. The white bulb needs to be replaced. Contact BD for assistance.</td>
</tr>
</tbody>
</table>
15 International Contacts

BD
7 Loveton Circle
Sparks, Maryland 21152 USA
Voice: (410) 316-4000 • Fax: (410) 527-0244
Technical Service and Support: 1-800-638-8663
www.bd.com

2100 Derry Road West
Suite 100
Mississauga, Ontario
Canada L5N OB3
Voice: 866-979-9408 • Fax: 800-565-0897

Monte Pelvoux 111 • 9th Floor
Col. Lomas de Chapultepec
11000 Mexico D.F.
Voice: 52 5 237 1200 • Fax: 52 5 237 1287

11 Rue Aristide Bergès BP4
38800 Le Pont de Claix France
Voice: 33 476 68 36 36 • Fax: 33 476 68 34 95

Akasaka DS Building
5-26 Akasaka 8-chome
Minato-ku, Tokyo 107-0052
Japan
Voice: (81) 3 54138181 • Fax (81) 3 54138144

30 Tuas Avenue 2
Singapore 639461
Voice: (65) 8610633 • Fax: (65) 8601590

Rua Alexandre Dumas 1976
04717-004 Sao Paulo, S.P. Brazil
Voice: (55) 11 5459833 • Fax: (55) 11 2478644